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Caption Trap Data 
 

Camera trap data comprises a large number of digital image (and sometimes video) files 
collected by cameras triggered by a change in the level of infra-red radiation reaching a sensor. 
Changes may be produced by an animal entering the field of view of the sensor, or by 
movement of objects (including animals) within the sensor field. An infra-red flash is used to 
record monochrome images from triggerings occurring at night. The camera may record single 
images, a sequence of images or a short video when triggered. Data is commonly stored on a 
removable SD card, and traps may be active for many days between data collections. The date 
and time recorded by the camera (and possibly other local information) is shown in a bar below 
the image. Dates and times may not correspond to the actual time of image collection, as the 
camera local time may not be correctly set. Image file names usually contain a number which 
increases sequentially. An example of an image obtained with such a camera during daytime is 
shown below: 

 
Figure 1 Daytime Camera Trap image of a rabbit 

An image recorded at night is as shown below: 

 
Figure 2 Night-time Camera Trap Image of a Cat 

Although the appearance or movement of animals occupying a significant proportion of the 
sensor field will trigger the camera, movements of leaves, grass or changes in solar illumination 
will also trigger the camera, resulting in the images recorded not showing any animals. Changes 
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in the physical environment of the sensor field (such as removing grass and branches affected 
by wind) may help reduce false triggerings, but may result in animals avoiding the area. 
 
If a bait (usually carrion) is included within the camera field of view, carrion eaters such as foxes 
or crows may spend considerable time moving around in order to eat it, resulting in large 
numbers of images of the same animal appearing in sequential images, closely spaced in time. 
The images below show a fox circling a bait. 

 
Figure 3 Fox circling a bait 

 
Automated methods of detecting the presence of animals in an image using machine learning 
have been developed, notably MegaDetector, which can be run from the EcoAssist application 
or from CamTrap Detector. EcoAssist requires a powerful local machine with at least 16 Bytes of 
RAM. An Nvidia Graphics Processing Unit greatly speeds processing. EcoAssist can use 
MegaDetector in generic mode, where it detects any animal, or it can be trained to identify 
particular species. CamTrap Detector uses a generic model to detect animals, people and 
vehicles. 
 
Machine learning facilities such as Megadetector are highly effective, but require substantial 
computing resources and may take many seconds per image. By contrast, non-fatigued human 
vision is fast and extremely accurate in detecting animals, but the task of detecting animals in 
the thousands of images taken even by a single camera is daunting, and some projects may use 
dozens of cameras. Caption Pro has been designed to facilitate inspection of large numbers of 
camera trap images and flagging of images in which animals appear using the Windows Tags 
field to store the names of animals appearing. Some simple detection algorithms which do not 
require training are provided, as well as an interface to results obtained from Megadetector. 
Megadetector is used only to detect the presence of animals – tagging to indicate which species 
are present is done visually. 
 

https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://petervanlunteren.github.io/EcoAssist/
https://github.com/bencevans/camtrap-detector
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Caption Pro Data Requirements and Processing 
In order to use Caption Pro for camera trap analysis, images in JPEG format should be copied to 
a folder structure on storage which is not read-only, as numerous temporary files are created in 
the image data folder. If the selected folder is read-only, no files are loaded. If the storage is an 
attached device, such as a USB or flash drive, estimated processing times may be too low. The 
individual images should have EXIF Date or Windows Modified Date metadata which allows the 
images to be sorted in time order. EXIF Date metadata may be Date/Time, Date/Time Original or 
Date/Time Digitized.  
 
The default settings for Camera Trap data add tags to the data in-place, but tagged images can 
be copied to another folder, or new images created in the same folder using appropriate 
Options settings. A database storing tag occurrence data (TagDB.vdb5) is created in in the folder 
containing the first file selected. This database should not be deleted 
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Reviewing Camera Trap Data with Caption Pro 
Camera traps may be used in a wide range of purposes including feral animal monitoring, 
species monitoring, density estimation, and game detection. They may be located in highly 
accessible areas, where scenes may frequently include cars and humans, or off-track where 
moving objects are much more likely to be animals (or birds). Baits (often carrion) may be used 
to attract animals into the camera scene,  
 
An indicator of the presence of animals in a baited camera trap is to examine the cumulative 
time profile of all the images. As animals often spend some time moving around the bait, the 
camera is triggered multiple times with a very short interval between images. Profiles of image 
count as a function of time and the same profile with visually assigned animal detections 
marked in red (shown by checking Analysis->ShowTagged)  is shown below: 

 

 
Figure 4 Image count vs time over 7 days (top) with one or more animal detections shown in red (bottom) 

It may be seen that animal detections are associated with a rapid increase in image count over a 
short period appearing as a vertical step, and that almost all camera triggerings are due to the 
presence of an animal.  
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A plot for a different data set over a similar period with mainly false triggerings, and animal 
detections shown in red  is shown below:  

 
Figure 5 Image count vs time over 7 days with a single animal detection shown in red. Time values are incorrect. 

This data set (from a baited camera) only recorded a single animal over 8 images out of 5000 
collected over a 7-day period. The animal was not attracted to the bait.  Most triggerings were 
from moving vegetation or changing shadow areas. Triggerings were less frequent at night, 
giving rise to the stepped profile. 
 
A data set from a single day using a non-baited trap is shown below: 

 
Figure 6 Image count vs time over a single day, with animal detections shown in red. Time values are incorrect. 

As non-baited traps only record animals passing, detections are less distinctive amid false 
triggerings from moving vegetation or shadows. Few images of animals are recorded. The step 
shown at 0900 hrs is from multiple triggerings when an animal passed very close to the camera, 
but the incomplete and unfocussed view meant that the animal could not be identified. 
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Data Required from Processing 
Data required from a camera trap data set is the species of animal detected, and sometimes the 
frequency of detection, or the identity of the animal. This data can be obtained by inspection of 
individual images using built-in computer facilities, and then adding metadata (usually as tags) 
to indicate the presence of an animal in an image. This process is very labour-intensive and 
without a large and competent volunteer labour force it is not an option, especially when a 
single camera may record a thousand images in a single day. Automated methods using 
machine learning (such as Megadetector) provide an alternative, but generally require overnight 
processing. The implementation of Megadetector in Caption Pro only identifies images 
containing animals – species labelling must be done manually.  

Using Caption Pro to Examine Camera Trap Data 
Starting Caption Pro offers the screen below which gives advice on its use for various purposes: 

 
Figure 7 Caption Pro usage screen 

Clicking Set Camera Trap Options sets various Options to values suitable for camera trap image 
analysis. These are: 
 

Option State 

Show Tags Checked 

Show Only Tags Checked 

Overwrite Original Checked 

Original Folder Selected 

File Order in Folders Date Taken 

Caption Height % 0 

Sub-Caption Height % 0 
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Where file Modified  Date is the same as Date Taken, processing will be faster if File Order in Folders is 
set to Modified Date. 
 
Pre-set text strings should be created to include the names of all animals expected to be detected. If 
individual animals are to be identified, specific names should be added (eg Goanna Rex) as described 
on page  28. Unexpected animals may be added to pre-sets during inspection. 
 

Loading Data 
Camera trap images are usually contained in a one or more folder with filenames which include a 
sequence number in the manner of digital cameras. Other parts of the filename may be a constant 
string or may contain a representation of the date on which the image was taken. The date on which 
the image was taken is stored in one or more of the EXIF date fields (Date/Time, Date/TimeOriginal, 
and Date/TimeDigitized). One of these dates is shown in Windows File Explorer as the image date. The 
file Modified date will be the same as this date unless the file has been processed in some way.  
 
For optimum speed of processing, images should be copied onto local storage and the folder 
containing the images should not be read-only. Estimated processing times will be too small if images 
are accessed on an attached storage device such as an SD card or USB drive. 
 
To load large number of files from a folder, the option File-> Load File(s) in Folder… should be selected 
and the folder containing the files browsed for. A screen similar to that shown below should then 
appear: 

 

 
 

Figure 8 Main screen after loading all files in or below folder using default Camera Trap options 

The Show Only tags option disables entry of caption and sub-caption data in order to speed up batch 
processing where the same tag is applied to many images. The entry boxes are coloured light yellow to 
indicate that they are disabled. 
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The amount of space available for tag entry can be changed by dragging the <Tags> divider sideways. 
Multiple files can also be selected directly via the File->Load Files… options. 
 
If the folder selected contains any image or video files which do not have .jpg, .JPG, .jpeg or .JPEG  
extensions, the Analysis menu option is not enabled. 
 
Caption Pro can also be launched with a multiple file selection from File Explorer by selecting the files, 
right-clicking and selecting Show More Options->Send To->Caption Pro. This option is useful for bulk 
application of tags, but there are limitations on the number of files which can be selected. 
 

Tagging by Visual Inspection 
Once the files are loaded, tags may be applied by visual inspection of each image using the Slideshow-
>Play option, which shows all the loaded images in the order selected in the Options screen. (For the 
Camera Trap options, this is Date Taken.) Ctrl-P toggles the slideshow between playing and pausing. 
The time between image displays  an be selected in the Options screen or via Slideshow->Interval and 
should generally be 250 msec. If an image takes more than 250 msec to load, as can happen for large 
images, the time interval will be increased to the first multiple of 250 msec greater than the load time. 
If an animal appears in an image, the slideshow should be paused and the sequence number of the 
image (shown in the title bar) should be noted as the start sequence number, together with the 
sequence number of the first image after its appearance in which it does not appear (end sequence 
number).  The start sequence number of the loaded images should then be displayed by entering the 
start sequence number in the box to the right of the Move button followed by enter or by clicking 
Move:  

 
Then enter the desired tag in the Tags box as shown below, or add the tag to the preset list via the 
Presete button and copy it to the Tags field: 
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Then click the  button at the bottom left of the main screen to show the screen below (which 

should have the SetCaptions/Tags to Entered Test radio button selected) and enter the end sequence 
number in the box to the right of the Apply to Seq button and click it to apply the tags to all images 
with sequence numbers between the start and end values: 

 

Using Caption Pro Analysis 
Clicking Analysis->Count vs Time shows a cumulative count vs time profile of the images  similar to 
those shown on pages 7-8. If the profile contains a number of large sharp steps as shown in Figure 4, 
this indicates that animals are moving in the viewed scene for some time and that tags need to be 
applied in bulk. This can be done manually in Caption Pro, or using the Exif Pro application, which 
allows application and removal of tags to a subset of loaded images. Megadetector uses machine 
learning to automatically detect animals in images and can be accessed from Caption Pro and 
applications such as EcoAssist. Output from this process can be loaded into Caption Pro. 
 
To apply tags using Caption Pro, right-click on the Time (or Time Interval) profile at the time when an 
image of an animal first appears. If this is not evident from the appearance of large step in the Count 
vs Time profile, the profile can be zoomed by clicking and dragging to create a box around the area of 
interest (near the origin) as shown below left. The zoomed display is shown below right. 

  
Figure 9 Zoom box defined on Count vs Time profile (left) and zoomed display (right) 

The sequence number of the image corresponding the cursor x location is shown in the lower left-
hand corner when the cursor is within the profile area. 
 
The Show Start button shows the first image after the start of the displayed region, and right-clicking 
on the display near a time-count point shows the image. If only a single time/count point is within 5 
pixels of  the cursor, the cursor changes to a + and right-clicking shows the image. If more than one 
point is close to the cursor, the cursor changes to a hand, and right-clicking shows the image with the 

https://download.cnet.com/ExifPro/3000-12511_4-10436338.html
https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://github.com/PetervanLunteren/EcoAssist
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lowest sequence number. The selected image point is shown in green, together with the sequence 
number as shown below: 

 
Figure 10 Display after right-clicking in zoomed region 

The image sequence number (172) is shown in both the Count vs Time Profile and in the title area of 
the main caption Pro window. Changing the displayed image with in the main Caption Pro window (via 

the  and controls at lower left or the left or right arrow keys on the keypad), changes the point 

shown in the Count vs Time profile, allowing graphical viewing of the time interval between images. 
The start and end sequence number for the appearance of an animal can then be determined and 
should be noted. 
 
A tag can then be applied to a subset of the loaded images by moving the display to the start sequence 
number be entering the start sequence number in the box to the right of the Move button below the 
image as shown below, and clicking Enter or the Move button. 

  
If the play button  is then clicked, the Batch Process Options screen appears as shown below 

 
 

 
Figure 11 Batch Process Options 

The option Set Captions/Tags to Entered Text can be used to apply text entered in the Tags field to all 
loaded files from the current sequence number up to the sequence number shown to the right of the 
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Apply to Seq button. The end sequence number should be entered in this box, before clicking Apply to 
Seq, and the entered tag string will be applied to all images between and including the start and end 
values. Note that clearing the Tag box will delete any applied tags. 
 
If the Menu option Analysis-> Show Tagged is checked, any files which have been tagged are shown as 
red dots on the profile as shown below.  

 
Figure 12 Time Analysis display with tags shown 

Deleting Tags 
Tags on individual images can be deleted using the Clear button at the lower left of the main 
Caption Pro screen. To remove tags from multiple images, any text should be deleted from the 

Tag box and the batch operation should be run using the  button. 

Highlighting 
Highlighting options are accessed via the Time Analysis Menu as shown below: 

 
Figure 13 Highlight Options 

Sequences.. highlights groups of images appearing in a rapid sequence. Changes ... highlights 
images which differ from their predecessor in hue or luminance. Both may detect the presence 
of animals in images but both suffer from false positive and negative detections.  The 
Megadetector->Load Output options allows loading of the JSON file produced by Megadetector 
and detections with a confidence within the confidence range are highlighted. Megadetector-
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>Confidence Range sets the confidence range for highlighting. Megadetector->Run runs 
Megadetector as a web service. 
 
The options are discussed in more detail below. Highlight results can be quickly inspected by 
right-clicking on the blue dots created by the process to show the image at the highlighted time. 
When a highlighted image is shown on the main screen the form (and taskbar) icon changes to a 
red background as shown below: 

 
Figure 14 Highlighted image (top) and non-highlighted image (bottom) 

This feature can be used to check for false negative detections. 

Sequences 
As an animal may only appear for in a few images out of several thousand, the step in the Count 
vs Time profile caused by its appearance may not be perceptible. The Highlight option allows 
highlighting of points on profiles where the time interval is less than or equal to a number of 
seconds, over a number of contiguous images as shown below: 

 
Clicking highlight shows blue points at images where this condition is satisfied: 

 
Figure 15 Highlighted points on Count vs Time profile 

Clicking on highlighted points shows the image in order to see if the sequence is caused by the 
presence of an animal. 

Changes 
The Changes.. option places a blue dot highlight on a time profile if an image differs significantly 
from its predecessor. It can be used to detect the presence or movement of an animal in an 
image, but will also pause if the shadow pattern in an image changes, or if there is a change 
between colour and monochrome images. If the animal colour is similar to that of the 
background, no pause will occur. The screen which appears when selecting this menu item from 
a Time Analysis profile is shown below: 
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Figure 16 Change detection screen 

A time profile point is highlighted when the similarity of an image to its predecessor exceeds a 
threshold value, as defined by the Pixel Change threshold and the Proportion of Pixels Changed. 
If it is checked, images are resampled to a much smaller number of pixels (15-120), using a 5:3 
aspect ratio and the difference in luminance and hue of each pixel in the displayed image and its 
predecessor is calculated. If the luminance difference exceeds the Luminance Change Threshold 
and the hue difference exceeds the Hue Change Threshold then the pixel is flagged as changed. 
If the Proportion of Pixels Changed exceeds another threshold value (between 0 and 15 15ths) 
then a highlight is generated. The progress bar at the bottom of the screen indicates what 
proportion of the loaded files have been processed after the Highlight button is clicked. 
 
As processing can be quite slow, the change detection can be stopped by clicking the Stop 
button. This enables the Remove and Cancel buttons. 
 
As with any computer-based image analysis method, Change detection does not match human 
or machine learning performance in animal detection in an image. Its advantages over computer 
vision facilities such as Megadetector are that it is fast, and does not require access to training 
data or powerful computing resources. However, its performance is highly dependent on the 
correct choice of parameters, and the optimum parameters for any data set will depend on the 
nature of the scenes shown in the images, and the expected size and colour contrast of the 
animal to be detected. For best results, the Resample Image size should be chosen so that the 
pixels of the expected animal in the image being processed appear within a single resampled 
pixel. For the default size of 15 pixels, giving a 5x3 image, this means that the expected animal 
size should occupy at least 1/15th of the scene. The optimum Luminance and Hue change 
thresholds will vary according to the colour of the animal being detected and its contrast with 
background pixels. 

Megadetector 
The Megadetector options allow reading of  .json files created by the auxiliary applications such 
as EcoAssist, or direct creation using a fixed Megadetector model as a web service. Web service 
operation is subject to a license limit. A histogram of the maximum confidence value for any 
detected entity for all loaded images can be generated, or images with values within a defined 
range can be highlighted in the time profile. The Megadetector options are shown below: 

 
Figure 17 Megadetector options 
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Licensing 
The free Demo license which is pre-installed with Caption Pro allows up to 1000 Megadetector 
analyses to be performed over the Demo period of 30 days. A permanent or fixed-term license 
increases the analysis license limit to 5000 and extends the license period indefinitely or for a 
fixed period after license issue. Including 500 or 100 Premium transactions as part of permanent 
or fixed-term Caption Pro licenses sets the analysis limits to 10000 or 20000 respectively.  
Adding 500 or 1000 Premium transactions as a Top-up increases the limits by 10000 or 20000 
respectively.  If multiple Top-Ups are applied, they should be downloaded more than 10 
minutes apart. Top-Ups cannot be applied to a Demo license. 
 
Fixed-term and multiple licenses are available with a generous discount. Fixed-term licenses are 
only available with multiple license purchases. Contact Aleka Consulting for a quote. 

Run 
Clicking Run shows the screen below, which allows loaded images to be sent to Megadetector 
running as a web service. Images where there is an animal detection with confidence within the 
bounds are highlighted and a file created which can be accessed if the detection bounds are 
changed. 

 
Figure 18 Run Megadetector screen 

The Time Estimate box shows the expected time to process all the loaded files assuming a 
processing time per image between 0.1 and 30 seconds. The Info button shows the screen in 
Figure 19. The processing time per image can be obtained by clicking the Test button, which 
processes the first 5 images and does not create an output file.  
 
The Test button must be clicked before the Start button. If it is not, the screen below is shown 
 

mailto:info@alekaconsulting.com.au?subject=Quote%20Request
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Figure 19 Testing to obtain image processing time 

This screen is also shown if the Into Button in the Time Estimate box is shown. 
Processing time per image is variable but mainly depends on the server speed It  is weakly 
dependent on image size, so an option to shrink the images by a selectable factor between 2 
and 6 before sending them to the web service is provided in order to reduce processing time. 
Note that a collection of 5000 image files may occupy more than 10 Gbytes of storage, all of 
which must be sent to the web server. 
If the web server is being accessed by other users, web requests will be queued and the 
processing time per image will be greatly increased. In this situation, it may be useful to defer 
processing all loaded images until a time when there are no other users active. 
 
Clicking Test processes only the first 10 images and results can be used to estimate the 
processing time per image using the data shown below:.  

 
. 
 
Clicking Process All processes all the loaded files. 
 
Processing at the loaded image sequence number shown below the Start button (Start seq) is 
initiated by clicking Start. This sequence number is updated as files are processed, so the 
detection process can be stopped and restarted if necessary. If there is no Internet connectivity, 
a warning message will be shown. 
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After processing, images with any animal detection with confidence between the upper and 
lower bounds will be highlighted as shown below: 

 
Figure 20 Megadetector detections highlighted 

Selecting the Copy option after highlights have been shown allows each detection to be 
analysed visually and appropriately tagged. 
 
 

Confidence Range 
This option set the upper and lower bounds for the maximum detected confidence level for any 
entity appearing the Megadetector output via the screen below. For the default model 
MegaDetector 5A used by EcoAssist and internally by Caption Pro, the only entities detected are 
animals, vehicles and people, but models can be built to identify particular species. 
 

 
Figure 21 Megadetector Confidence Range screen 

If the upper bound is set to the default value of 1.0, the value of the lower bound used 
determines the compromise made between false negative and false positive detections, and 
should be set after examination of the histogram of confidence levels. High values will tend to 
include only high confidence detections, but will result in false negative detections if animals do 
not have strong visual contrast with their surroundings, or if parts of them are occluded. This 
advice can be viewed via the Info button. 
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An example of a false negative detection is shown below: 

 
Figure 22 Example correct (left)  and false negative (right) detection using a 0.8 lower confidence bound 

The two successive images (taken 7 secs apart) have maximum detection confidences of 0.82 
and 0.46 respectively, despite them being visually very similar. Using a lower confidence bound 
of 0.8, only the first will register as a detection. 
 
A low confidence level bound will have fewer false negative detections but will include more 
false positive ones. Low confidence detections are usually false, but may not be. 
 
The nature of detections can be explored by setting the upper bound to a value of less than 1.0 
and examining the images with maximum confidence values in this range, either by right-
clicking on highlights or by copying all highlighted images to a new folder and examining them. 
 
After setting a confidence range, highlighted images can be copied to a separate folder and 
analysed separately. The smaller number of images allows more reliable human detection of 
animals and determination of their species.  
 
If different detection bounds are required after a run, these can be changed via the Confidence 
Range screen. 
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Histogram 
The histogram option shows the distribution of maximum confidence values over the set of 
images. The distribution is highly variable, as the examples below show: 

 

 

 
Figure 23 Confidence value histograms and count vs time profiles for 3 datasets. A confidence range of 0.85-1.0  is 
used to define highlights. 

The top dataset above is from a baited camera trap running for 7 days, where the bait did not 
attract any animals. The small number of animal detections come from animals crossing the 
camera scene. The count vs time profile shows fewer triggers at night but no sharp steps. There 
are a very large number of false triggering images which Megadetector interprets as containing 
animals but with low confidence. 
 
The middle dataset is from another baited trap running for 7 days which attracted a large 
number of animals, resulting in many high-confidence detections and large, sharp steps in the 
profile where animals move within the camera scene for periods of a few minutes.  
 
The lower dataset is from a non-baited trap running over a single day. The absence of steps 
indicates that animals did not spend long within the camera scene, but there were a significant 
number of high-confidence detections of animals briefly present. 
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Load Output 
The Load Output option allows output from Megadetector to be used to highlight images. As 
implemented in EcoAssist and Caption Pro, the output is in the form of a .json format file 
created in the folder containing the images. The Caption Pro output file has the name 
MegaDetectorOutput.json, the EcoAssist output file is called Image_recognition_file.json and 
the CamTrap Detector file is called ct.0.1.0.json. These files should not be renamed. Selecting 
any  of these files from this option highlights images on the time profile where the maximum 
detection confidence is within a range defined by the Confidence Range menu item. The default 
range is 0.9-1.0. 

Copy 
The Highlight Copy option images highlighted using Megadetector or other algorithms to a 
selected folder. If the Changes algorithm is used, only images which differ from their 
predecessor will be copied and these may not include all those showing animals. 
 
 The default destination folder is a sub-folder with the name Highlighted in the folder containing 
the loaded files. This folder is created if it does not already exist, and cleared of any existing 
content. An option to load the content into Caption Pro is presented to facilitate visual 
inspection and tagging. 
 
Note that if the default option for the highlighted images is used, any subsequent reloading of 
the camera trap images should exclude images in sub-folders. 
 
In the case where false triggerings dominate animal detections, analysing the content of this 
folder will greatly reduce the effort of identifying animal species in images. The confidence 
range lower limit can be adjusted to ensure that all animals are detected in images. 

Errors 
If more than 5 errors (such as timeouts from internet connection failures, or server crashes) 
occur during processing, the run will be stopped. Errors can be examined from the Errors menu 
item in the main Caption Pro screen. 

Concurrent Users 
Multiple users may access the web service concurrently. In this case, web requests will be 
queued and processing times per image will be multiplied by the number of concurrent users. 
Optimum processing times are achieved with single users. 
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Adding Tags from a Slideshow 
If there are not large numbers of images of the same animal, data can be displayed via the 
Caption Pro Slideshow option, which displays multiple loaded files in sequence automatically. 
Slideshow options can be set via the File->Options.. screen as shown below: 

 
Figure 24 Options screen with Slideshow options highlighted 

The slideshow interval should be set to 500 msec for 4 Mpixel camera images and Repeat 
Slideshow should be unchecked. For larger images, 250 msec should be selected but most 
images will be displayed at actual intervals of 500 or 750 msec.  
 
Once a slideshow is stopped or paused, the image can be tagged or captioned by entering text 
into the appropriate boxes. 
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Figure 25 After loading image files and clicking Slideshow 

Selecting Play (or clicking Ctrl-P) starts the slideshow, with the image filling the window. The 
slideshow can be paused by clicking the second menu item (now labelled Pause) or by clicking 
Ctrl-P again, if an animal or part of an animal appears in the image as shown below. The 
slideshow can be stepped backwards or forwards via the left or right arrow keys, or via the 
menu options. 

 
Figure 26 Image showing part of a kangaroo 
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Pause on Change 
The Pause on Change option in the slideshow enables pausing  when a change is detected as 
described on page 15. The appearance of the screen is slightly different as shown below: 

 
Checking Pause on Change enables the pausing. If it is not checked, no pausing occurs. 
 

Copying Tagged or Captioned Images 
Once an image of an animal is obtained, a copy of this image (and optionally up to 5 images 
preceding or following the image) can be transferred to another folder via the Copy To Folder 
menu option or by clicking Ctrl-K. This sets this folder to ‘MyPictures/Camera Trap Images’ by 
default and creates the folder if it does not exist. The screen below is then shown: 

 
Figure 27 Copying slideshow images to another folder 

A different save folder can be specified via the Browse button if required. Clicking OK copies the 
file displayed (and optionally up to 5 images preceding or following the displayed image) to the 
folder specified. This file can then be accessed via the File->Load File(s) option and cropped or 
further processed with an image editing tool (Windows default is Windows Photos). The 
processed file should be saved with a different file name and then opened if captioning is 
required. 
 
If the slideshow is stopped rather than paused, the caption boxes appear. Captioned images can 
then be saved into any folder specified in the Options screen (as shown in Figure 24) clicking the 
Add to Image button. After adding the caption, the captioned image in the specified save folder 
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will be shown, but selecting Play in the slideshow menu (or clicking Ctrl-P) will resume the 
slideshow at the sequence number at which it was stopped. 
 

Tagging with Exif Pro 
Exif Pro is a mature Windows application for managing digital photos in formats which support 
EXIF metadata. Although it has not been updated for 10 years can be run in a Windows 11 
environment.  The JPEG format used by most camera traps is supported, and camera trap data 
can be rapidly loaded into it, and Windows tags added as described in this video. Animal name 
tags can only be pasted or typed into the Edit Tags screen – loading from a text file created by 
another application does not work.  Images tagged using this application can be loaded into 
Caption Pro and a tag summary generated as described on page 26. 
 
Although Caption Pro can also perform bulk tagging, the selection of images to tag is graphical 
rather than numeric and may be more conveniently performed using Exif Pro.  

Summarising Tag Data 
A text summary of tag data can be obtained via the Analysis-> Tag Summary menu option. If any 
tags are present in the loaded files, an option to scan these for start and stop times to create 
the tag summary will be presented as shown below.  

 
 
Yes should generally be selected.  

https://download.cnet.com/ExifPro/3000-12511_4-10436338.html
https://www.youtube.com/watch?v=MSeOyeXjEhg
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A tag summary screen is then shown as below: 

 
Figure 28 Tag Summary Screen 

The lower grid shows the start and stop time of each group of files tagged contiguously and the 
upper grid shows the sum of durations and image counts for each tag present for all the loaded 
files. A duration of zero indicates that the tag was only applied to a single isolated image. If 
there are multiple occurrences the same animal at the duration is the time between the start of 
the first occurrence and the end of the last occurrence. The content of the upper Tag Summary 
grid can be copied to the clipboard and pasted into a report. 
 
If tracking of individual members of a species is required, distinctive tags can be applied (eg 
Goanna 1, Goanna 2). 
 
If only the appearance of animal is required for reporting, only a single image containing the 
animal needs to have a tag applied. 

 

Adding Captions 
If selected camera trap images are to be captioned, text may be typed in directly to the Caption 
and sub-caption boxes. Text typed into the caption box will appear centred as continuous text, 
with any line breaks ignored. The font size is adjusted to fit within the percentage of the original 
image height specified to the right of the caption box.  Multiple lines of text can be entered in 
the sub-caption box and font size will be adjusted to fit the longest line within the height of the 
box specified on the right of the text box.  
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An example of a captioned image is shown below: 

 
Figure 29 Example of Captioned Image 

Adding Pre-set Text Values 
If image analysis is being performed by a number of different people, pre-set texts can be used 
for captioning or tagging to ensure standardisation. Pre-set texts can be accessed via the Presets 
button, which shows the screen below left if Show Tags is not checked in the Options screen 
and below right if it is selected: 

  
Figure 30 Preset Texts screen if Show Tags is not selected (left) and if selected (right_ 
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 Texts can be added via the Add button, which shows the screen below: 

 
Figure 31 Add Preset Texts screen 

Multiple values can be pasted in from the clipboard, with each value on a new line. The multiple 
values might be the names of all the different animals expected to be shown in the images. 
After pasting in the values and clicking add, the Preset screen appears as below: 

 
Figure 32 After adding preset texts 

One or more texts can be selected by clicking the text twice so that the checkbox appears to the 
left of the texts. If a single text is selected, its value can be edited via the Edit button. After 
selection, the texts can be copied to the caption or tags via the Copy To button. If multiple texts 
are selected and copied to the caption, values are concatenated and spaced by a comma and a 
space. If Add to Existing is checked, selected values are added to existing tags. If it is unchecked, 
existing tags are replaced. 
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Caption data can be used to create Windows tags by checking the appropriate boxes in the 
Options screen as shown below. If the Caption Height and Sub-Caption height are both set to 
zero, the image is not changed, but entered data is added to the file metadata, and processing is 
much faster. 

 
Figure 33 Options for creating tags with Camera Trap options set 

Caption data is split at commas, and each text string between commas is used as a separate tag. 
Semicolons should not be used in tags. Tag Information can be displayed in Windows Explorer 
using Details view: 
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Figure 34 Windows Explorer details view showing tags 

The presence of animals over a number of frames may be detectable in Icon view as shown 
below. 

 
Figure 35 Multiple images of the same animal detectable in Icon view 

If this is the case, the images can be selected and then sent to Caption Pro by right-clicking and 
choosing Send To-> Caption Pro. The same caption (and optionally tags) can then be applied via 

the Batch option .  
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Licensing 
As downloaded, Caption Pro comes with a free Demo license which allows unrestricted 
operation for 30 days after installation or until 25 captions or tags  have been applied, and a nag 
screen is shown each time Caption Pro is started.  If these limits are insufficient,  a full, 
permanent license can be purchased from here.  Fixed-term licenses (which deny access after a 
period of time and are only available for multiple purchases) can be obtained at a reduced unit 
cost from Aleka Consulting. 
 
License key installation is done by clicking on the License top-level menu to show the following 
screen:  

 
Figure 36 Licensing screen 

The screen shows License OK at the bottom left of the screen if the license is valid and indicates 
the license type. If the license is not OK, the reason is shown. The screen also provides a link to 
purchase a permanent license from the Aleka Consulting web site via PayPal by clicking the Buy 
License button. A license may be used on up to 2 computers.  
 
Premium transactions may be used for Premium face recognition or Megadetector analyses 
with limits as shown. 

  

https://captionpro.com.au:444/AlekaConsulting/index.php/caption-pro-desktop-license-1-year/
mailto:info@alekaconsulting.com.au
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Auxiliary Programs 
A number of programs may be used in conjunction with Caption Pro as follows: 

Exif Pro 2.1 
Exif Pro is a mature, ex-commercial product intended for photographers which allows the 
addition of multiple Windows tags to photos. After selecting the folder containing the images, 
selecting a group of thumbnails below the main image and right-clicking allows tags to be added 
or deleted as shown below. 
 

 
Figure 37 Exif Pro 

Tags can be defined via  the image at the lower left. Tagged file can be loaded into Caption 

Pro for further analysis in the same was as if the tags had been created in Caption Pro. 
 
Exif Pro 2.1 can be downloaded from a number of software libraries including CNet and 
Softonic. Source code is available at https://github.com/mikekov/ExifPro. 
 
 
 

  

https://github.com/mikekov/ExifPro
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EcoAssist 
EcoAssist is a Python application which can run on any platform (including Window)s from 
Netherlands ecologist and data scientist Peter van Lunteren. It requires the use of the Anaconda 
Python data science distribution (download a light version for Windows from here), and Git for 
Windows.  These must be installed before attempting to install EcoAssist. Installation should not 
be attempted unless you are familiar with using GitHub and have considerable knowledge of 
Windows. EcoAssist uses the Megadetector computer vision model, which is best run on Nvidia 
Graphics Processing Unit (GPU). It will run if this is not present, but much more slowly. 
 
EcoAssist is installed via an install.bat file, which may take some time to run. As it is downloaded 
from another computer it raises a Windows warning about harming your computer when run 
unless it is unblocked via the Properties tab. Once it is installed, it takes some time to start up 
and respond to clicking on any of the buttons. After starting, and selecting the folder containing 
the images, the main screen is below: 

 
Figure 38 EcoAssist main screen 

The default model (MegaDetector 5A) detects only animals and people. It does not attempt to 
detect animal species. Process all images in the folder specified should be checked, and Deploy 
Model clicked. Once it is running a progress screen appears: 

https://github.com/PetervanLunteren/EcoAssist
https://github.com/conda-forge/miniforge#miniforge3
https://gitforwindows.org/
https://gitforwindows.org/
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Figure 39 EcoAssist progress screen 

Once processing is finished, a large tick is shown in the Run Model pane: 

 
Figure 40 EcoAssist screen after completion of processing 

The output json file is created in the analysis folder with the name Image_recognition_file.json. 
The file contains data on the file name, the maximum detection confidence (zero if no entities 
are detected) and details of the detections. It has the format as shown below: 

 
Figure 41 EcoAssist result file format 

This file should be browsed for when loading data into Caption Pro. It should not be renamed. 
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CamTrap Detector 
CamTrap Detector is an application available for a number of platforms, including Windows. 
After downloading the msi installer (for either a GPU or a CPU-only machine) , double-clicking 
on it first warns that the application has not been signed and then shows a simple start screen: 

 
After loading a folder of images, the estimated run time is shown. The estimated speed is about 
2 sec per image on a 2022 laptop with a 2.6 GHz processor 

 
After completion, a number of export options are shown: 

 
Choosing the Image Directory and exporting only animal images includes all images where 
animals are detected with a confidence >0.1, with bounding boxes shown. A large number of 
false positive detections with low confidence appear. 
 

https://github.com/bencevans/camtrap-detector
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Exporting to a JSON file produces a file with the name ct.0.1.0.json, which can then be loaded 
into Caption Pro, via the Megadetector->Load Output option. Upper and lower bounds for 
highlighting can then be set. This file should not be renamed. 
 
Despite its speed, CamTrap Detector detects few animals with high confidence and its results 
are very different from EcoAssist or the Megadetector web service. 
 


